02 - Importing Data
Contents

02 - IMPORTING DATA ...................................................................................................................... 1

SUPPORTED DATA TYPES .................................................................................................................. 1

Analyzing texts in any language (Unicode supported) ......................................................... 2

IMPORT AND GROUP YOUR DATA .................................................................................................... 2

................................................................. ................................................................. 2

................................................................. ................................................................. 4

Moving and sorting documents ........................................................................................................ 5

More data import options .................................................................................................................. 6

Document sets .................................................................................................................................... 8

Document variables generated automatically during the import process 9

CREATE NEW TEXT OR TABLE DOCUMENTS .................................................................................. 9

Create new text documents ............................................................................................................ 9

Create new tables .......................................................................................................................... 10

................................................................. ................................................................. 11

EXTERNAL FILES ............................................................................................................................ 12

TEXT DOCUMENTS .......................................................................................................................... 16

Importing texts ............................................................................................................................. 16

In-text tables .................................................................................................................................. 17
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Links to websites embedded in texts</td>
<td>17</td>
</tr>
<tr>
<td>PDF DOCUMENTS</td>
<td>18</td>
</tr>
<tr>
<td>Working with PDF documents</td>
<td>19</td>
</tr>
<tr>
<td>IMAGE DOCUMENTS</td>
<td>20</td>
</tr>
<tr>
<td>Importing images</td>
<td>20</td>
</tr>
<tr>
<td>Working with images</td>
<td>21</td>
</tr>
<tr>
<td>AUDIO AND VIDEO</td>
<td>22</td>
</tr>
<tr>
<td>Play and edit audio and video files</td>
<td>24</td>
</tr>
<tr>
<td>TABLE DOCUMENTS</td>
<td>24</td>
</tr>
<tr>
<td>Importing table documents</td>
<td>24</td>
</tr>
<tr>
<td>TRANSCRIPTS</td>
<td>30</td>
</tr>
<tr>
<td>Importing transcripts without timestamps</td>
<td>31</td>
</tr>
<tr>
<td>Importing transcripts with timestamps</td>
<td>31</td>
</tr>
<tr>
<td>Supported timestamp formats</td>
<td>34</td>
</tr>
<tr>
<td>FOCUS GROUP TRANSCRIPTS</td>
<td>35</td>
</tr>
<tr>
<td>Converting an already imported text into a focus group transcript</td>
<td>38</td>
</tr>
<tr>
<td>SURVEY DATA FROM EXCEL</td>
<td>38</td>
</tr>
<tr>
<td>Importing survey data and other structured data from Excel spreadsheets</td>
<td>38</td>
</tr>
<tr>
<td>How should the Excel table be structured?</td>
<td>38</td>
</tr>
</tbody>
</table>
Starting the import process ................................................................. 39
Imported texts in MAXQDA ................................................................. 42

SURVEY DATA FROM SURVEYMONKEY ............................................. 43

TWITTER DATA .................................................................................. 48
MAXQDA’s Twitter analysis features .................................................... 48
Import Twitter data ............................................................................. 48
Twitter data in MAXQDA ................................................................. 53

YOUTUBE DATA ................................................................................ 55
What YouTube data analysis options does MAXQDA offer? ............... 55
Importing YouTube data ..................................................................... 56
Imported comments in MAXQDA ...................................................... 58
Imported YouTube transcripts ............................................................ 60

SUBTITLE DATA (SRT) ..................................................................... 60

WEB PAGES ....................................................................................... 61
Saving web pages with the MAXQDA Web Collector ......................... 61
Importing collected web pages into MAXQDA .................................... 64
Direct import of web pages in HTML format ....................................... 66

BIBLIOGRAPHIC DATA (ENDNOTE, ZOTERO ETC.) ......................... 66
How Does MAXQDA Support Working with Bibliographical Data? ....... 67
Remarks on the RIS format ................................................................. 68
Exporting literature data from Citavi, Endnote, Mendeley or Zotero ....... 69
Import bibliographic data from other programs ..................................................... 73
What happens during the import? ........................................................................... 73
Analyzing literature data in MAXQDA ................................................................. 75
Exporting bibliographic data in RIS format ........................................................... 76

STRUCTURED DOCUMENTS (PREPROCESSOR) .................................................... 76

What are structured texts? .................................................................................... 76
Import structured data with the preprocessor ......................................................... 76
## 02 - Importing Data

### Supported Data Types

The following table provides an overview of what data types you can import into MAXQDA:

<table>
<thead>
<tr>
<th>Data</th>
<th>Format</th>
<th>Examples and Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Texts, transcripts, transcripts with time stamps and associated media files, Focus group transcripts.</td>
<td>Word (DOC/X), OpenOffice (ODT), Rich Text (RTF), Text (TXT)</td>
<td>Interview transcripts, field notes, observation logs. Time stamps allow the synchronization of transcript and sound. Speakers in group discussions are automatically coded.</td>
</tr>
<tr>
<td>Documents</td>
<td>PDF</td>
<td>Academic journals, literature, news articles</td>
</tr>
<tr>
<td>Tables</td>
<td>Excel (XLS/X)</td>
<td>Spreadsheet with survey result</td>
</tr>
<tr>
<td>Images</td>
<td>PNG, TIF, JPG, GIF, SVG, BMP</td>
<td>Photo diaries, advertisement images</td>
</tr>
<tr>
<td>Audio files</td>
<td>MP3, WAV etc.</td>
<td>Recorded interviews (these can be transcribed and synchronized with the transcript)</td>
</tr>
<tr>
<td>Video files</td>
<td>MP4, AVI, MPG, MOV etc.</td>
<td>Recordings of group interactions, YouTube videos  Data can be transcribed and synchronized with the transcript. Video and audio can be coded directly.</td>
</tr>
<tr>
<td>Surveys, questionnaires</td>
<td>Excel (XLX/S), SPSS (SAV)</td>
<td>Exported data matrices from the open-source software LimeSurvey</td>
</tr>
<tr>
<td>Pre-structured texts and tables</td>
<td>Same as for texts and tables</td>
<td>Exports from the online data collection tool kernwert.de can be coded automatically during the import</td>
</tr>
<tr>
<td>Websites</td>
<td>Downloads from the MAXQDA Web Collector (free extension for Chrome browser)</td>
<td>Company presentations, news articles</td>
</tr>
</tbody>
</table>
Tweets | Direct import of Tweets | Social media analysis of trending topics
---|---|---
YouTube comments | Direct import from YouTube | Social media analysis of trending topics
Video file subtitles | SRT | Film analysis
Bibliographic Data | RIS, TXT | For literature reviews

**Important:** In Windows, ODT documents can only be imported in MAXQDA if Microsoft Office (2003 or later) is installed on your computer. Otherwise, the documents can be saved in RTF format and then be imported into MAXQDA.

All text and table documents imported into MAXQDA can be edited in the “Document Browser.” This means you have the option of fixing typos, deleting or adding text, etc. This is also possible once you have done some coding and/or creation of memos. This means you don’t have to have a completed document to start your coding. PDFs, images, and audio/video files cannot be edited in MAXQDA.

You can also create new texts or spreadsheets in an opened project at any time, into which you can paste content from the clipboard.

**Analyzing texts in any language (Unicode supported)**

The fact that MAXQDA supports Unicode makes it possible not only to import and analyze documents in any script, from Japanese to Cyrillic to Arabic, but also to create codes and variables in these languages. The support for Unicode text is available in every MAXQDA function.

Unicode is an international standard with the goal of standardizing all known languages and characters. This makes it possible to work with various languages in the same document. One sentence can be in English, the next in Mandarin, and the next in Arabic. In MAXQDA, even codes and variable names can be created with “foreign” characters, and searches and in-vivo coding are possible with any language.

**Import and Group your Data**

**Importing data via the Import tab**

The **Import** tab provides numerous functions for importing different data types. When you create a new project, the tab is automatically opened so that you can start importing data directly:
How to import standard data such as texts, PDF documents, tables, images or audio / video files:

1. Go to the **Import** tab and click on the appropriate icon for your data type on the left, e.g. **Transcripts** to import interview transcripts and **Texts, PDFs, Tables** to import Word files, PDF documents or Excel files.
2. A dialog window will appear, in which you can select the files to be imported. Press **Ctrl** (Windows) or **cmd** (Mac) to select multiple files at the same time.

After making your selection, the files are inserted into the open MAXQDA project and displayed in the "Document System" window. The following image shows that seven texts ("Kim", "George", etc.) have been added.

By default, all inserted texts, PDF documents, tables and images are saved in the project file. This means that you can modify or delete the source file with no effect on the file in the project. Conversely, if you make changes to a file in MAXQDA, e.g. improving typing errors, without changing the source file. Exceptions are audio and video files, they are not stored in the project because of their size but in a special folder for external files. The same applies to PDF documents and images that exceed an adjustable file size. For more information, see "External Files".

When inserted, MAXQDA takes the filename as a document name, it can be modified later, avoiding duplication. Depending on the type of document, the documents are given different symbols.
Note: Using the other icons on the tab, special data types, such as focus group transcripts, survey data, or data from Twitter can be imported. The specifics of these imports are described in detail in their own sections.

Ordering the documents in document groups

Once you’ve imported your documents you’re ready to start your analysis. Most people don’t start with the analysis immediately, though, and prefer to organize the documents in folders, as they might do on their computer’s hard drive. Rather than using folders, MAXQDA uses document groups. They work just like folders do on your computer – you can name them and drag documents into them.

There are two ways to create a new document group:

- Click the New Document Group icon in the "Document System" toolbar.
- Right-click on the root folder in the “Document System” and select New Document Group from the context menu.

MAXQDA then creates a new document group at the current position and automatically assigns a name and number. To give the document group a meaningful name, click on it with the right mouse button and select Rename. Alternatively, click the name once with the mouse button to select the line, and then click the name again.

Suitable names for document groups are e.g. the data types (individual interviews, group discussions, document analyses, etc.) or differentiation criteria resulting from the sampling (first survey wave, second survey wave, ecclesiastical organizations, public-law organizations, etc.).
Please note: You can create document groups on up to two levels. This means that each document group at the top level can contain subgroups. These subgroups cannot contain any further subgroups.

You can change the order of the document groups at any time using drag-and-drop. In addition, the assignment of documents to document groups can be changed at any time by clicking on the document symbol in the "Document System" with the mouse and, holding down the left mouse button, moving it to where you want to assign the document. You do not have to specify the document group to which it is to be assigned when importing the document.

Moving and sorting documents

Moving individual documents

You can arrange the order of the documents in the "Document System". Just click and drag the document to the desired position.

Moving multiple documents

You can select multiple separate documents by holding down the Alt key (Windows) or option key ⌥ (Mac) and then move this selection while holding down the mouse button. To select a range of documents, first click on one document and then click on a second document while holding down the Shift key ⇧. This then selects all the documents between these clicked documents.

Moving multiple documents by activating them

To move multiple documents at once, first activate these documents by, for example, holding down the Ctrl key (Windows) or the cmd key (Mac) and then clicking on them. Now click on a document group with the right mouse button and select Move Activated Documents Here.
Sorting documents

To sort the documents in a document group, choose **Sort Documents** from the context menu of the document group and then the required sorting order in the drop-down menu. Sort criteria include **Document Name**, **Last Edit**, and **Text Length** (only text, table, and PDF documents are taken into account).

To sort document groups by their names, right-click on the root folder of the documents, and choose **Sort in Ascending Order** to sort them from A - Z or **Sort in Descending Order** for the reverse order.

**Please note:** You will often be working with documents or document groups whose names consist of numbers or whose names contain numbers, e.g. Interview 1, Interview 2, Interview 3. In the case of more than ten documents or document groups, it is recommended to use double-digit numbers for their description, so that the documents are sorted according to the order of numbers, e.g. Interview01, Interview02, ..., Interview48. In the case of more than 100 documents or document groups, corresponding three-digit designations should be used, e.g. Interview001, Interview002 etc.

**More data import options**

You can import documents not only from Import tab but also through several other
functions:

- Click the **Import Documents** icon on the toolbar of the "Document System".
- Or use the keyboard shortcut **Ctrl+D (Windows)** or **cmd+D (Mac)**.
- Or click on the root folder in the "Document System" with the right mouse button and select **Import Documents**.
- Or, right-click the document group to which the document is to be assigned. From the context menu, choose **Import Documents**.

As described above, a dialog window opens in which you can select which file to import.

**Please note:** The imported documents are imported into the selected document group, i.e. marked in blue. If no document group or root folder is selected in the "Document System", MAXQDA inserts the new documents at the top of the document "tree".

**Importing documents via drag and drop**

Files can be imported via drag and drop: Select one or several documents in the Windows Explorer or Mac Finder and simply drag the documents into the "Document System" with the mouse. Then drop the documents in the desired position.
Tip: To import the documents of a whole folder into MAXQDA, drag the folder from the Windows Explorer or Mac Finder to the “Documents System”. MAXQDA then creates a new document group with the same name of the file folder at the top of the document “tree” and imports all documents that MAXQDA can import. If the folder contains subfolders, these are also created as separate document groups.

Document sets

MAXQDA makes it possible for you to create and save a temporary grouping of documents. While each document can only be in one document group, it can be in as many document sets as you wish, because document sets are only made up of shortcuts to the documents. In other words, a document set can be deleted without it having any effect on the document. If that same document were deleted from a document group, however, it would be deleted from the project along with all of its memos, coded segments, links, etc.

Document sets can be created via activation. You can activate a document by right-clicking on it and selecting Activate from the context menu. You can see that a document has been activated, because it turns red and a red arrow appears just to the left of the document symbol.

Tip: For quick, easy activation, left-click on the document symbol. You can also activate all documents in a document group at once by clicking on the folder icon.

After activating all the documents that you want to create a set out of, you can create that set as follows:

1. Right-click on the word Sets at the bottom of the “Document System”.
2. Select New set.

MAXQDA then creates a new set with the name “Set 1” and adds all activated documents to this set. You can click on the name with the right mouse button and choose another that is more appropriate. Document sets are manipulated like document groups; you can activate all the documents in a document set at the same time and use all the options for working with document groups (Codes, Memos, Variables, Links, etc.).

Modifying document sets at a later stage

Individual documents can be deleted from a document set: Right-click on a set and select Remove document from set. Or drag and drop documents to move them from set to set.
**Tip:** You can drag a document (or a number of documents) into a set at any time. Drop the document(s) into the desired set and MAXQDA will insert it/them directly at the top of the set.

Document sets are very practical when you want to analyze a certain selection of documents. Forming a document set is also an easy way to save the result of a complex variable activation process.

**Document variables generated automatically during the import process**

Each document contains a data record of variables (“document variables”). When you import a document, a record is simultaneously generated – much like during your first visit to a new doctor. If at the time of import a data record containing variables is generated, firstly only certain internal MAXQDA variables will be saved.

You would like to know which variables? Then click on **Variables** (“System Fields”) in the context menu of the document to see these internal variables. MAXQDA will display the number of coded segments and memos available for this document in the columns **Coded Segments** and **Memos**.

![Overview of Variables for a newly imported document](image)

Some information will appear at the cursor if you hover the mouse over a document name in the "Document System" window and wait a moment.

**Create New Text or Table Documents**

MAXQDA lets you not only import and export texts and tables, but also create them, for example for ethnographic descriptions of researched items.

**Create new text documents**

There are several ways to create a new text document:

- Click the **New Text Document** icon in the toolbar of the "Document System", or
• go to the Import tab and click the Create Document icon, or
• press the key combination Ctrl+T (Windows) or cmd+T (Mac), or
• right-click on the root folder of your documents in the “Document System” and select New Text Document to insert a text at the top of the document list, or
• click on a document group with the right mouse button and select New Text Document to create a text at the top of the selected document group.

MAXQDA will automatically assign the document a name in the form of “Document nn,” where nn is a consecutive number. Of course, you can always change the name later. After creating a new document, it is automatically opened in the “Document Browser” and put in Edit Mode, so you can start to type or paste text from another program into it.

Create new tables

To create a new table, go to the Import tab and click on the text (not the icon) Create Document. Then click New Table Document in the menu that appears. You can freely select the number of rows and columns.
Select the number of columns and rows when you create a new table

Please note: When creating a new table, no new columns can be added later.

Convert text document into a table

You can convert a text document automatically into a table document, i.e. to paraphrase the text in another column:

1. Open a text document by double-clicking on it in the “Document System“.
2. Then go to the Import tab and click on Convert Text > Insert Displayed Text as a Table Document
3. A dialog box will appear, in which you can specify the number of columns.

Please note: The original text will be preserved in the conversion to a table.

A new table document appears in the "Document System", which you can recognize by the symbol and which will bear the same name as the source document. Each paragraph of the source text appears in a separate line of the new table. If you have selected more than one column for the table, the text appears only in the first column.
As this picture shows, this conversion function makes it easy to paraphrase and summarize texts in MAXQDA. When you activate Edit mode, you can paraphrase the texts in the empty columns of the newly created table.

External Files

In general, all documents will be imported into the MAXQDA project file, meaning the original file remains in place. You can modify or delete the original file without affecting the imported document in MAXQDA. This concept holds a great advantage over other QDA software, in which the primary files are constantly at risk of being modified “from the outside.”

With MAXQDA you can connect audio or video files to their transcriptions and import PDF and image files, which means that the “one project = one file” concept is not always optimal. If you were working with many audio/video, image, or PDF files, for example, your project file would quickly become very large, which would slow down processes in MAXQDA and make it almost impossible to move the file.

For this reason, MAXQDA does not save audio and video files in the project file and imported PDF and image files only up to a certain size (default setting 5 Megabytes). Instead they are saved in an external folder. You won’t notice any difference in the way you work with the documents in MAXQDA; the icons in the “Document Browser” look just like they would if the documents were saved in the project file.
The threshold for the file size can be set in the overall MAXQDA preferences. Preferences can be opened by clicking on the gear wheel on the upper right corner of the MAXQDA Main Menu.

You can also set the location where external files are to be saved. If you do not change it, the default location for all external files will be as follows:

- for portable license installations: [MAXQDA 2020 Files]MAXQDA_Externals
- for Windows normal license installations: [My documents]MAXQDA_Externals
- for Mac normal license installations: [My documents]/MAXQDA_Externals

Please note: All your external documents will be saved in a global external folder. If you wish to save externals in a project-specific folder, you should create a folder for the designated project. However, it can be useful to work with a global external folder from which external files can be accessed by multiple MAXQDA project files. For this reason, when you delete a document, the associated media file will not be deleted without confirmation, as the file could still be linked to other documents.
What actually happens when a PDF or image file larger than the set maximum size is imported into the “Document System”?

- You are informed that the file is saved externally and is not embedded in the project.
- The document is added to the list in the “Document System” just as it would be if it were a smaller file.
- The document is visualized with the PDF or image icon as is the case with smaller files.
- The document is copied into the “MAXQDA_Externals” folder unless you have chosen to have external files saved elsewhere. The original document remains in its original location.

What happens to a document in the “Document System” when it is linked to a media (audio/video) file?

- The location of the original file is saved in the Properties menu of the document.
- The original media file is never saved as part of MAXQDA project file, even if it is smaller than the maximum file size.
- The media file is copied into the folder for external files. The original document remains in its original location.
- When importing a text file with timestamps, MAXQDA also looks through the file for timestamps, creates a List of timestamps synchronizes the text with the audio/video file.

Which file is actually used – the original or the copy?

MAXQDA always looks for the original first – it looks for the file based on the path that is saved in the properties menu of the document. If the original is not found, the copy of the file in the external files folder is used. This file is then loaded. In other words, the original file can be moved or deleted without it affecting the proper functioning of MAXQDA.

Be careful when using the same file name for different files!

It is possible to import several documents with the same name into the “Document System” (e.g. three files named “Interview 1”). This is only a problem if the file is larger than the set maximum and must be saved in the external files folder. When the most recently imported file is saved, it automatically replaces the older file with the same exact name.
What happens when you change the external files folder for a project that already has external files saved in the default external files folder?

In this case, MAXQDA will ask you if you would like to move the documents from the previous location to the new external files folder. The documents are only moved once you confirm this. Since this action changes the global setting for all projects, all files are moved from the former external files folder to the new.

Can you import an externally saved document into the project file at a later time?

Yes, you can. To do this, right-click a document in the “Document System” and select Properties. Then click Embed document.

Can you store a document outside the project file at a later stage, that is, save it in the folder for external files?

Yes, you can do this, too. To do this, right-click a document in the “Document System” and select Properties. Then click Store documents externally.

To store several documents outside the project file, go to Home > External Files > Store Documents in Folder for External Files. A dialog box will appear listing all documents stored in the MAXQDA project file. Here you select all the documents that you want to store externally.
Function for storing files externally

How do you transfer external files from one computer to another?

To share the project with team members and colleagues, including the external files, follow these steps:

1. Send the MAXQDA (MX20) project file.
2. Bundle all external files by clicking on External Files > Bundle External Data Files in the Home tab. MAXQDA then compresses all external files associated with the current project into a Zip archive, which is named after your project (e.g. “Projectname.mx20.zip”) and saved in the same place as your project file.
3. Transfer this newly created Zip file.

Procedure on the receiving end:

1. Open the MX20 project file.
2. Click External Files > Unpack Bundled Data Files in the Home tab and select the Zip archive in the Windows dialog box that appears. MAXQDA then unpacks the archive and moves the linked files to your external files folder. If you saved the zip archive in the same folder as the project file, MAXQDA automatically accesses the archive and unzips the files on request.

If a document is linked to an audio or video file, the original location of the audio/video file will be listed in the document properties. If a document with this name isn’t found in the appropriate folder, the file in the external files folder will be opened.

Text Documents

Importing texts

You can import texts into MAXQDA, as described here:

- by clicking the Import Documents icon in the “Document System”, or
- by clicking the Texts, PDFs, Tables icon in the Import tab.
If you want to import text documents into MAXQDA you should briefly think about how to prepare them for the import. If you want to analyze certain sections of text as a single unit, for example, it makes sense to put them together in the same paragraph. MAXQDA enters a new paragraph number after each hard return. This makes it easier to then automatically code these paragraphs in MAXQDA.

Here are the things to remember when importing a text document:

- All formatting aspects – like bold, italics, etc. – are carried over to MAXQDA.
- All fonts and text sizes are carried over.
- Paragraph formatting (e.g. right-justified, line height) is also carried over.
- The text can contain tables, pictures, graphics, etc.
- If objects like graphics are imported or not can be determined in the local preferences of the “Document System”, which you can open by clicking on the gear symbol at the top right of the window.
- Contents of header and footer are ignored.

**In-text tables**

As listed above, MAXQDA can import tables included in text documents, and you can code parts or whole cells of these tables in MAXQDA. The only limitation here is that the size of the table can no longer be changed once it has been imported.

**Please note:** As a rule, we recommend that you use tables in text documents only sparingly. This not only increases your analysis options (e.g. automatic coding at paragraph level), but also increases the performance of the display. We particularly advise against importing interviews in a table structure in which each response is contained in a separate row.

**Links to websites embedded in texts**

Documents imported into MAXQDA can also have links to websites (hyperlinks) in them. Clicking on the link in MAXQDA brings up the webpage or HTML file in the default browser.

Hyperlinks are always made up of two parts: the visualization (whether it be a button, picture, or text) and the URL, which is the information about the location of the file, which may be a WWW address. By hovering over the link, you can see the location/URL in the tooltip that appears. Usually, this is not otherwise visible.
Please note: When you enter an Internet address in a text in MAXQDA, it will automatically transform into a clickable hyperlink when you close Edit Mode.

You can find more notes and advice in Links in MAXQDA.

PDF Documents

Importing PDF documents

You can import PDF documents into MAXQDA, as described here:

- by clicking the Import Documents icon in the "Document System", or
- by clicking on the Texts, PDFs, Tables icon on the Import

Text from a PDF document as a separate text document

After a PDF document has been imported into a MAXQDA project, you can extract the text from the PDF document. Images and formatting are ignored, only the plain text is inserted as a new text document in the "Document System".

Click on a PDF document in the "Document System" and select the function Insert PDF Text as New Document. The new text appears directly below the clicked document.
**Tip:** With many PDF texts, the conversion makes it possible to search within paragraphs when conducting a lexical search.

**Working with PDF documents**

There are some special considerations when working with PDF documents, as the PDF format was not conceived for text editing but rather as a layout format for printing, and hence are much bigger files than simple text documents.

**Tip:** PDF documents may contain pages in both portrait and landscape orientation or pages in different sizes. MAXQDA displays all of the pages in a PDF document in the same page orientation and page size as the first page. If your document contains mixed page orientations and sizes, it might be necessary to rotate them into the same orientation before importing the document in MAXQDA or to delete a title page that is smaller than the following pages.

**Saving PDF files outside the MAXQDA project file**

By default, all PDF files smaller than 5 MB will be saved in the project file upon insertion. PDF files larger than 5 MB are not saved in the MAXQDA project itself, but rather in the folder for externally saved files, and generate only a reference to the externally saved data. You can customize the maximum file size as well as the location for externally saved files through MAXQDA’s preferences, which you can access via the gear symbol in the top right corner of MAXQDA.

**Tip:** If you are working with many large PDF files (e.g. with a total size of more than 1 GB), it makes sense to store them externally so that the MAXQDA file remains small and can be easily secured. For optimal performance it is recommended that externally saved files be located on the local hard disk and if possible not on a network, although
the acceleration of network speeds mean that this poses less and less of a problem.

Coding text and image segments

Text and image segments in PDF documents can be coded with the mouse. Select and create a frame around the desired segments to subsequently code them. MAXQDA does not distinguish between text and image encodings in regard to code frequency; however in the Coding Query when searching for overlap, the query will search independently for overlap/intersection in text and image documents. Overlap between text segments and image segments will be ignored. The “Near” function for image segments always returns a result of 0, both in the Complex Coding Query and the Code Relations Browser.

If a text is in the format of a scanned PDF file, Optical Character Recognition or OCR, a text recognition process, must carried out with a suitable program before the import into MAXQDA. This process makes it possible to mark and code the text in MAXQDA later, otherwise it would only be possible to mark images.

Absence of paragraphs in PDF files

PDF documents, unlike text documents, have no paragraph structure per se. MAXQDA functions that rely on the paragraph structure can therefore not be used in PDF documents. These functions include, among others, automatic coding with the parameters “Sentence” or “Paragraph”, as well as the “Near” function for segments in the Complex Coding Query and Code Matrix Browser.

Navigating through the "Document Browser"

As soon as a PDF document is displayed in the Document Browser, several clickable icons will appear in the toolbar. You can flip forward and backward, adjust the zoom and use the bookmarks for navigation (many PDF files have several bookmarks, e.g. one per chapter).

Tip: MAXQDA does not support editable PDF form fields. To display content from PDF forms, save your PDF document via a PDF printer as a new PDF file that contains the contents of the form fields as pure text.

Image Documents

Importing images

You can import Images into MAXQDA, as described here:
• by clicking the Import Documents icon in the "Documents System", or
• by clicking on the Images icon on the Import tab.

Working with images

When working with images, there are a few special aspects to consider that are described in this section.

Saving image documents outside MAXQDA projects

Normally all image documents of less than 5 MB are saved directly in the MAXQDA project. Image documents larger than 5 MB are not saved directly in the project, but rather in the folder for external files, and only a reference referring to the externally saved file is generated. You can customize the maximum file size as well as the location for externally saved files via the MAXQDA preferences, which you can access by clicking on the gear symbol in the top right of your window.

Tip: If you are working with many large image files (e.g. with a total size of more than 1 GB), it makes sense to store them externally so that the MAXQDA file remains small and can be easily secured. For optimal performance it is recommended that externally saved files be located on the local hard disk and if possible not on a network, although the acceleration of network speeds mean that this poses less and less of a problem.

Coding image segments

In image documents, borders can be drawn around the selected area with the mouse which can be subsequently coded like text segments, meaning they can be dragged and dropped into a code. With the Complex Coding Query and Code Relations Browser, the “Near“ function for image segments always returns a result of 0.

Rotating and zooming into images

As soon as an image document is displayed in the “Document Browser“, several icons for viewing the image will appear in the toolbar. You can zoom in or out of the image as well as rotate it clockwise (images imported from digital cameras and mobile phones should automatically be correctly rotated by MAXQDA provided the correct information has been saved in the image).
Audio and Video

You can import audio and video files into MAXQDA, as described here:

- by clicking the **Import Documents** icon in the "Documents System", or
- by clicking on the **Audios or Videos** icon on the **Import** tab.

There are some special considerations regarding audio and video files.

MAXQDA supports the following formats as standard:

**Audio**
- Windows: MP3, WAV, WMA, AAC, M4A
- Mac: MP3, WAV, AAC, CAF, M4A

**Video**
- MP4, MOV, MPG, M4V, 3GP, 3GGP
- Windows: additionally AVI and WMV
- For video, a MP4 file with the video codec H.264 / AVC is recommended.

Audio and video files are generally not imported directly into a MAXQDA. Instead, they are stored in the MAXQDA Externals folder and linked to a text document in which you can, if necessary, save a transcript.

When importing an audio or video file, MAXQDA creates a new text document with the name of the media file and assigns the newly added document the inserted media file. The media file itself is stored in the MAXQDA external folder. If a file with the same name already exists in the Externals folder, MAXQDA asks if the existing file should be overwritten. You can adjust the location of the external address in the MAXQDA settings. The settings are called up via the gear wheel at the upper right edge of the window.

In the "Document System", you will recognize a text document with the associated media file by the additional symbol displayed in addition to the document symbol: a musical note for audio files and a video camera for video files.
Assigning an existing transcript to an audio or video file during import

During the import of an audio or video file, MAXQDA asks you whether there already is a transcript that you want to assign to the media file. If you select Yes a dialog window pops up where you can select the transcript file.

If the selected transcript does not contain time stamps, MAXQDA will ask you whether you want them to be generated automatically:

![Options for automatically generated time stamps](image)

MAXQDA will automatically place time stamps in the transcript at the selected interval, making it easier to listen to the original sound of a selected text passage.

**Please note:** The automatic assignment of time stamps to the text is linear to the length of the audio or video file. This means that a click on a time stamp does not always play back precisely the clicked text, but positions the audio or video file approximately near the text passage.

Assigning audio/video files to a text document

You can also assign a media file to an existing text document. To do this, right-click on the document in the "Documents System" and select Properties. Here a link to a media file can be assigned or changed at any time.

To do this more quickly you can right-click on the document and choose Link
Play and edit audio and video files

Audio and video files can be played and edited in MAXQDA's "Multimedia Browser". For detailed information, see Analyzing Videos.

Table Documents

Importing table documents

You can import Excel documents into MAXQDA, as described here:

- by clicking the Import Documents icon in the "Documents System", or
- by clicking on the Texts, PDFs, Tables icon in the Import tab.

What happens when a Excel spreadsheet document is imported into a MAXQDA project?

- The first worksheet in the Excel workbook will be imported.
• Hidden columns in Excel will also be imported.
• The columns are numbered according to their order, whereby the contents of the first row will be used as the column header.
• The entries in the first line of the table are used as headings.
• The row order will remain the same when imported.
• The font will be standardized.

### Importing table documents into the “Document System”

Please note: Excel spreadsheets that use Object Linking and Embedding (OLE) to integrate embedded objects such as Word documents, PowerPoint slides, etc., can have a significant impact on performance, so we advise against using them. Instead, external links are much better suited for linking tables with objects outside the MAXQDA project.

### The table view in the “Document Browser”

Table documents in MAXQDA will be automatically formatted. It is not possible to modify the text format. You can zoom into the table using the zoom icon in the “Document Browser” toolbar. The font will appear accordingly larger or smaller. The height of the rows will be automatically set to the height of the largest cell.

Please note: When importing, the columns are numbered according to their order in the Excel document. The number is at the beginning of each column heading and cannot be changed post-import.

During the import, the first line of the imported document is copied as the column header. You can adjust this heading by right-clicking on a column and selecting Edit Entry:
When you import a table each column will be assigned a type automatically:

- Text
- Numeric
- Date/Time

To change a column type, open the drop-down menu “Type.”

Please note: It is not possible to modify the column type if the column contains coded segments.

The column widths and column positions can be modified using Drag & Drop. Like overview tables, table documents in MAXQDA can be sorted by clicking the column header. The original order can always be restored by right-clicking on the column header and selecting Reset sorting. Alternatively, you can click on the empty column header just above the row number.
You can access the following options by right-clicking on the column header:

- **Hide** – hides the column.
- **Edit** – allows the modification of column name and column type.
- **Select fields** – opens a window in which the columns to be displayed can be selected.
- **Reset Sorting** – restores original order after import.

**Notes on table rows**

The row numbers are fixed when the table is imported into MAXQDA, and cannot be modified.

A row in the table corresponds to exactly one paragraph. Within a cell, there is no differentiation between paragraphs.

**Editing table documents**

The contents of individual cells can be modified. In order to do so, click on the **Edit mode on/off** button in the top right corner of the “Document Browser”.

**Tip:** To insert a paragraph within a cell, hold down the **Alt key** (Windows) / **option key** (Mac) and press **Return**.

**Coding table documents**

Any text segment of any cell can be coded. First, double-click on the cell in order to select the contents. The cell will then be outlined in yellow, and you can mark a text segment. All of the usual MAXQDA coding options, including color-coding and coding with emoticons, are now available. It is not possible to code across multiple cells.
Please note: When you hide a column, the corresponding coding stripe in the “Document Browser” will also be hidden.

Notes on retrieval functions in table documents

The retrieval options for coded segments in table documents are identical to those for text documents. For example, overlap will be handled in the same way as it is with normal text. The retrieval functions also include hidden columns and are based on the current configuration of the table. Retrieval functions for a single row correspond to those for a single paragraph.

The Near function in the Code Relations Browser and Complex Coding Query applies to columns in table documents. This means that only the vertical proximity of two codes, and not the horizontal or diagonal proximity, will be taken into account, and that coded segments in different columns will never be found, when using the Near function.

Click on the source data in the “Retrieved Segments” to indicate the coded text in the “Document Browser” and display the corresponding column.

Memos in table documents

As with all documents in MAXQDA, you can assign memos to table documents. You can assign a memo to a table document like this:

- Right-click a selected text section in a cell and select **Insert Memo for Selection** to compose a memo for the text section.
- Right-click on a cell and select **Insert Memo**.
- Double-click in the memo column to the left of the table to create a memo to the first character of the first cell at the click position height.
Adding memos to a table document

When you click on a memo symbol, MAXQDA will indicate to which text or cell this memo is assigned.

Please note: When a column is hidden, the memos assigned to the cells in this column will also be hidden.

Table documents and visual tools

In principle, hidden columns in table documents will be taken into account when using Visual Tools.

Code Matrix Browser functions as with any other type of document, as only the number of coded segments for a particular code will be analyzed.

Code Relations Browser functions as with overlapping in normal text. Overlap can only occur within a particular cell. The “Near” function will search only for coded segments in the same column.

Codeline Each row represents a paragraph in the Codeline – the column structure is ignored in this case. Hidden columns will be taken into account. Paragraphs will be sorted in their original order.

Document Comparison Chart As with the Codeline, each row in the table represents a paragraph – the column structure is ignored. Hidden columns will be taken into account. Paragraphs will be sorted in their original order.

Document Portrait This tool operates differently than with regular documents. Columns will be more or less ignored; cells will be processed from left to right, then top to bottom. A one-dimensional structure is then created, which is displayed as usual in the Document Portrait.
Exporting table documents

Table documents cannot be printed directly from MAXQDA; they can, however, be exported in Excel format. Click the Export Displayed Document button in the Document Browser or select Project > Print > Displayed Document from the main menu. Alternatively, you can right-click on the document in the “Document System” and select Export Document.

Transcripts

Transcribing recordings is easy with MAXQDA, because MAXQDA provides all the standard transcription functions, such as automatic speaker exchange, autocompletes with defined shortcuts and timestamps for synchronizing transcriptions with audio or video files. All the functions for transcribing in MAXQDA are described here.

MAXQDA also lets you import transcripts that were created automatically or with specialized transcription software, including f4/5 transcript, Inqscribe or Transcriber Pro. The latter is usually the case when a professional service provider has transcribed your recordings.

The transcripts created with such software usually contain timestamps corresponding to certain audio or video files. MAXQDA automatically includes these timestamps. Most transcription programs create their transcripts in standard text formats which can be imported directly into MAXQDA without conversion.

When creating or ordering transcripts, it’s a good idea to insert a timestamp at the end of paragraphs least as well as at easily misunderstood points within a paragraph. Timestamps let you open and play the original sound file with just one click.

A transcript with timestamps then looks like this:

I: So, Robert. Could you please describe your current living situation for me? #00:00:10.5#
B: Sure. Uhm, at the moment I am living with my parents. In my old room in the basement. I did have a room in the dorms at college but I am taking a semester off and wasn’t sure where I'd end up going. I am looking for an internship at the coast, so I'll probably find a place with a roommate there soon. #00:00:30.1#

Example transcript with timestamps at the end of paragraphs
Importing transcripts without timestamps

If your transcripts do not contain time stamps, you can import them via Import > Transcripts > Transcripts without Timestamps. Alternatively, you can simply drag the transcript from Windows Explorer or Mac Finder to the "Document System".

Importing transcripts with timestamps

Importing transcripts combined with their corresponding audio or video files:

1. Ensure that you have the appropriate audio or video recordings for all transcripts that you want to import. You can use the transcripts and the media files in the same folder and under the same name.
2. In MAXQDA, go to the Import tab and select the function Transcripts
3. In the drop-down menu, select the entry of the transcription software that was used to create the transcript. Select Transcript with Timestamps if you do not know the software used.
4. A dialog window will appear in which you can select a transcript for the import. If you press Ctrl (Windows) or Cmd (Mac), you can also select several transcripts.
5. Click Open and MAXQDA will search the file for timestamps and ask for the associated media files. Select them in the dialog window that opens, and click Open. If you don’t want to link any media files to the transcript, click Cancel. MAXQDA will ask if you want to import the transcript without a media file and if you want to keep the timestamps in the text.

Importing transcripts from AmberScript

AmberScript is an online transcription app with automatic speech recognition. To import a transcript from AmberScript:

1. Edit the transcript online
2. Export the transcript in DOCX or JSON format. Make sure to activate the options to include timestamps and speakers.
3. In MAXQDA go to the Import tab and choose Transcripts > From Amberscript (.json)
Importing transcripts from f4x Spracherkennung

**f4x Spracherkennung** is an online transcription app with automatic speech recognition. To import a transcript from f4x Spracherkennung:

1. Edit the transcript online.
2. Export the transcript in RTF format.
3. In MAXQDA go to the **Import** tab and choose **Transcripts > From f4/f5 transcript**

Importing transcripts from HappyScribe

**HappyScribe** is an online transcription app with automatic speech recognition. To import a transcript from HappyScribe:

1. Edit the transcript online.
2. Export the transcript in MAXQDA(.txt) format.
3. In MAXQDA go to the **Import** tab and choose **Transcripts > From HappyScribe**

Importing transcripts from Otter.ai

**Otter.ai** is an online transcription app with automatic speech recognition. To import a transcript from Otter.ai:

1. Edit the transcript online.
2. Export the transcript in TXT or DOCX format.
3. In MAXQDA go to the **Import** tab and choose **Transcripts > From Otter.ai**

Importing transcripts from SimonSays

**SimonSays** is an online transcription app with automatic speech recognition. To import a transcript from SimonSays:

1. Edit the transcript online.
2. Export the transcript with the "MAXQDA" option or in DOCX format.
3. In MAXQDA go to the **Import** tab and choose **Transcripts > From SimonSays**

Importing transcripts from Sonix

**Sonix** is an online transcription app with automatic speech recognition. To import a transcript from Sonix:

1. Edit the transcript online.
2. Export the transcript in DOCX format.
3. In MAXQDA go to the **Import** tab and choose **Transcripts > From Sonix**

**Importing transcripts from Temi**

**Temi** is an online transcription app with automatic speech recognition from [Rev.com](http://www.rev.com). To import a transcript from Temi:

1. Edit the transcript online
2. Export the transcript in DOCX format.
3. In MAXQDA go to the **Import** tab and choose **Transcripts > From Temi**

**Importing transcripts from Trint**

**Trint** is an online transcription app with automatic speech recognition. To import a transcript from Trint:

1. Edit the transcript online
2. Export the transcript in DOCX or XML format.
3. In MAXQDA go to the **Import** tab and choose **Transcripts > From Trint**

**What happens when you import a transcript?**

- MAXQDA creates a new text document with the transcript.
- The audio or video file is copied into the **folder for external files** and assigned to the transcript.
- Text documents with the associated media file can be recognized by their special symbols in the "Document System": a musical note 🎵 for audio files and a video camera 🎥 for video files.

MAXQDA converts the timestamps in the transcript to internal MAXQDA timestamps and entries in the timestamp table and simultaneously removes them from the text for better readability. The chronology of the timestamps is checked in the text: Timestamps that refer to an earlier time than those previous to them are removed.

**Tip:** If you do not assign an audio or video file during import, you can do this later by right-clicking on the document name and selecting the **Properties** option.
Texts that already contain timestamps when imported can, if necessary, be subdivided more precisely with further timestamps. For more information, see the Transcription section.

Supported timestamp formats

MAXQDA automatically recognizes the following timestamp formats in a transcript:

<table>
<thead>
<tr>
<th>Software</th>
<th>Timestamp format</th>
</tr>
</thead>
<tbody>
<tr>
<td>easytranscript, f4 &amp; f5transcript</td>
<td>#hh:mm:ss-x#</td>
</tr>
<tr>
<td>HyperTRANSCRIBE</td>
<td>[hh:mm:ss.xxx]</td>
</tr>
<tr>
<td>Inqscribe Transcriva</td>
<td>[hh:mm:ss.xx]</td>
</tr>
<tr>
<td>Transana</td>
<td>(h:mm:ss.xx)</td>
</tr>
<tr>
<td>Transcribe</td>
<td>[hh:mm:ss]</td>
</tr>
<tr>
<td>Rev, HappyScribe</td>
<td>[hh:mm:ss]</td>
</tr>
<tr>
<td>Transcriber Pro</td>
<td>hh:mm:ss</td>
</tr>
<tr>
<td>General</td>
<td>hh:mm:ss.x</td>
</tr>
<tr>
<td></td>
<td>hh:mm:ss.xx</td>
</tr>
<tr>
<td></td>
<td>[h:mm:ss]</td>
</tr>
</tbody>
</table>

If you are using a different transcription software, you may be able to customize the timestamps by finding and replacing digits in the program with one of formats that can be imported:

**Note:** If you import any text document that contains timestamps in one of the formats listed above, MAXQDA will automatically detect the timestamps and ask you for the associated media file.
Focus Group Transcripts

MAXQDA offers a variety of functions for the analysis of focus groups. To use these analytical tools, it is necessary to import focus group transcripts using the focus group import function. If you are transcribing a focus group interview in MAXQDA or if you have already imported a transcript, you can also convert the text into a focus group transcript later. When importing a focus group transcript or converting a text into a focus group transcript, all speech contributions are coded with the respective speaker name, which makes it easy to differentiate between individual speakers in the analysis.

To import a focus group transcript to MAXQDA, select Focus Group Transcripts in the Import tab and choose your transcript format from the drop down menu. Linking the focus group transcript to an audio or video file and working with time stamps works just like importing a regular transcript.

- Each contribution begins in a new paragraph. At the beginning of each contribution the name of the participant appears, followed by a colon. Using bold type or special fonts for the names will not affect the import process, however upper and lowercase will be taken into account. Names like “Lisa B.” or “Gábor” with spaces and special characters are not a problem when importing. The subsequent text will be coded with the names of the speakers, up to the point where the next speaker is indicated.
- MAXQDA will tolerate a space that is accidentally set before a name or in front of a colon, and treats the associated names to be identical.
- The names of the speakers that appear before the colon can be a maximum of 63 characters in length.
- Sections of text at the beginning of the transcript (in which no colon occurs within 63 characters) will not be coded. This provides the opportunity for you to include a title and general information about the focus group for easy recognition.
- Timestamps originating from the transcription software F4 or F5 will be treated as usual: MAXQDA will ask if you wish to associate the corresponding audio/video file with the transcript. The timestamps will be integrated into the MAXQDA project and removed from the text.

Let’s take the following interview with multiple speakers as an example:

---

**Interview Transcript**

Lisa B.: “I think it’s important to have a variety of options available.”

Gábor: “I agree, but I also think it depends on the situation.”

Lisa B.: “Yes, I think so too.”

Gábor: “But what do you mean by ‘options’?”

Lisa B.: “I mean, you know, the ability to choose...”

Gábor: “Oh, I see what you mean.”

---

Let’s see how this can be coded in MAXQDA.

**MaxQDA Coding Example**

- Lisa B.: “I think it’s important to have a variety of options available.”

  - Speaker: Lisa B.
  - Timestamp: (if available)

- Gábor: “I agree, but I also think it depends on the situation.”

  - Speaker: Gábor
  - Timestamp: (if available)

- Lisa B.: “Yes, I think so too.”

  - Speaker: Lisa B.
  - Timestamp: (if available)

- Gábor: “But what do you mean by ‘options’?”

  - Speaker: Gábor
  - Timestamp: (if available)

- Lisa B.: “I mean, you know, the ability to choose...”

  - Speaker: Lisa B.
  - Timestamp: (if available)

- Gábor: “Oh, I see what you mean.”

  - Speaker: Gábor
  - Timestamp: (if available)

---

Let’s take a look at the coding in MAXQDA.

**MAXQDA Coding Interface**

- **Focus Group Transcripts**

  - **Home**
  - **Import**
  - **Codes**
  - **Memo**
  - **Variables**
  - **Analysis**
  - **Mixed Methods**
  - **Visual Tools**
  - **Reports**
  - **Stats**
  - **MAXDictionary**

  - **Import focus group transcripts**

---

Now let’s see how this can be analyzed in MAXQDA.

**Analysis in MAXQDA**

- **Codes**
  - **Lisa B.**
  - **Gábor**

- **Statements**
  - “I think it’s important to have a variety of options available.”
  - “I agree, but I also think it depends on the situation.”
  - “Yes, I think so too.”
  - “But what do you mean by ‘options’?”
  - “I mean, you know, the ability to choose...”
  - “Oh, I see what you mean.”

---

This is just a simple example to illustrate how focus group transcripts can be imported and analyzed in MAXQDA. With the powerful tools and features of MAXQDA, you can perform in-depth analysis and gain valuable insights from your focus group data.
**Moderator:** Well good morning to everyone – thank everyone for being here. We’ve been chatting and I’ve already outlined what we were hoping for this discussion in your packs. We know you come from a variety of employment backgrounds and we are hoping to guide the discussion and get your opinions about along various topics connected to the various current financial crises and general economic downturn. To start with though we just want to find out what things are prominent – most occupying your minds.

We need to ensure that we’ve covered the important things during discussion. So perhaps if we could go round the room – you say what matters – roughly in the context of what this discussion is all about. Just to assist the transcriber eventually, if you could just say your name when you start talking after a while … it won’t go in the transcript itself.

**Moderator:** How do you feel now about your job and how secure do you feel? What changes have you experienced in this regard? Please do talk about relationships at work and morale if it’s relevant to you.

**Lucas:** It has changed now where I work. It’s an international firm. Hope you don’t mind me not saying what type of work it is. You are really gagged and your jobs on the line if it gets out. We’re under the cosh basically. In the last couple of years two other big parts of the company have shut up shop or move to the Far East.

**Moderator:** So do these other closures affect morale?

**Lucas:** Well … it’s more like it’s a great weapon to use when they want you to work extra time for no money. The stress – there’s just no morale at all. You get the impression that HR are lining you up for the sack. It’s because of employment laws now – they’ve got more leeway to discipline you if you are off sick for instance. Half the time people are off sick because of stress.

Following a successful import, MAXQDA opens the transcript immediately in the “Document Browser”, and from the coding stripes in the margin you can see that the speech contributions have already been coded. During the import MAXQDA creates a new document in the “Document System” with the filename of the transcript. This document has its own symbol, which allows you to immediately recognize that it relates to a focus group. Below the document, the speakers of are listed individually, with the number at the end of the line indicating the number of contributions. The speakers are attached to their transcripts. If you move the document, the speakers will move with it. Only the order of speakers can be adjusted with the mouse. Like other documents, focus groups documents can be assigned to a document group or set.
In the “Code System” you will see a very similar listing: At the bottom of the Code System a code with the name of the imported data will appear, with the speakers listed as subcodes, and the same symbol as in the “Document System”. Speaker codes and the speakers in the document are attached: If you change the order of the speakers or their names in the Code System, their order will also change in the Document System, and vice versa. This also applies when a focus group transcript is deleted: If you remove a transcript from the “Document System”, the corresponding code and its subcodes will be deleted from the “Code System”.

**Tip:** You can choose to place focus group speaker codes at the top of the Code System, in the “Code System” window settings.

The fact that the speakers are available both in the "Document System" and in the “Code System” opens up extensive possibilities for the analysis, as the speakers can be activated as independent codes and as document subsets. More information: [Analyzing Focus Groups Data](#).

**Tip:** After importing the transcript you should check the names of the speakers for typographical errors. This will avoid frustration later, in the case that the same person appears twice under different names because the name was written or spelled differently. Since the speaker code cannot be deleted, you would have to make the appropriate modifications in a word processing program and then import the transcript again.

When you import multiple transcripts, a unique code will be assigned to each focus group along with subcodes for the respective speakers. The top-level codes can be moved within the same Code System, but the speaker codes are firmly attached to their top-level code, and their order can be modified only under this top-level code.
Tip: The automatic coding function for speakers may be useful for other types of documents in which multiple individuals interact, for example forum discussions or comments on YouTube videos.

Converting an already imported text into a focus group transcript

Sometimes you realize that it would have been better to import a text as a focus group transcript into MAXQDA after you have already imported and coded it as a normal text document. Or you have transcribed an interview with several participants in MAXQDA and would like to code all of the speakers and their contributions automatically. In both cases you can use the function Convert Text>Insert Displayed Text as a Focus Group Transcript, which is available in the Import Tab. First, open the relevant document and then start the function. MAXQDA will insert a copy of the text as a focus group document:

- The speakers contributions will be coded automatically and corresponding codes for each speaker will be created in the „Code System“ window.
- MAXQDA will copy all existing coding information and memos into the newly created document, also the variable values and the summaries.
- A linked media file will be linked to the new document, too.
- The links in or on the document will not be transferred.

Survey Data from Excel

Importing survey data and other structured data from Excel spreadsheets

With MAXQDA you can import structured documents from an Excel spreadsheet in XLS/S format, during which individual table cells will be automatically coded. In addition, variable values can be assigned to the individual texts. This is particularly useful when importing (online) surveys with standardized and open answers.

How should the Excel table be structured?

When imported into MAXQDA, each row of the table becomes a new document, wherein the contents of the cells form the document content and are coded with the respective column header. The structure of the Excel table corresponds to the principle of a data matrix of a standardized survey. This logic is illustrated in the table below:
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Group A</td>
<td>Person 1</td>
<td>Great conference!</td>
<td>The catering was a bit tight</td>
<td>22</td>
<td>high</td>
</tr>
<tr>
<td>Group A</td>
<td>Person 2</td>
<td>Best keynote I have heard in a long time</td>
<td>I especially enjoyed the pre-conference workshop</td>
<td>25</td>
<td>medium</td>
</tr>
<tr>
<td>Group B</td>
<td>Person 3</td>
<td>I especially enjoyed the pre-conference workshop</td>
<td>none</td>
<td>21</td>
<td>medium</td>
</tr>
<tr>
<td>Group B</td>
<td>Person 4</td>
<td>Great job - keep going!</td>
<td>Please make workshops longer in the future</td>
<td>31</td>
<td>low</td>
</tr>
</tbody>
</table>

Each row of the table contains a case, and the columns “Open Question 1” and “Open Question 2” contain the respondent’s responses to the respective questions. The “Variable” columns contain standardized information for each case in the form of variables. Of particular importance are the first two columns “Document group” and “Document Name”, which assign the individual rows of the table to documents in MAXQDA’s “Document System”.

**Please note:**
1. It is not absolutely necessary to have a column for the “Document Group” as MAXQDA can also create a new document group, into which all documents are imported, during the import process. However, at least one column is required, which contains the document name.
2. MAXQDA supports one sublevel for document groups. These can be created and addressed during import using the backslash, e.g. “Survey\New York”. 3. The column headings should be short and concise, as this is much more practical for further work and MAXQDA only imports the first 63 characters of the headings. Only if the column headings differ in the first 63 characters, MAXQDA will be able to handle the columns as different.

**Starting the import process**

To import Survey data from an Excel file, go to the Import tab and select the Survey data> Import data from Excel spreadsheet function. You can also import documents from an Excel spreadsheet on the Import tab from Excel spreadsheets. In principle, however, both calls lead to the same result.
Selecting import settings

After calling up the function, the desired Excel file must be selected from the file dialog box. This opens a window where you can enter the settings for the import.

The two top settings determine which columns contain the Document Group and the Document Name. If the names “Document group” and “Document Name” are used in your table as column headings, MAXQDA will automatically select them, but this
choice can be changed at any time.

If you select [Create new document group] for the entry “Document group”, MAXQDA will automatically import all documents into a new document group. MAXQDA automatically selects this option, if your table doesn’t contain a column with the heading “Document Group”.

Tip: When importing survey data, it is recommended that you select the ID’s of the respondents as a column for the document names. In this way, you can avoid any ambiguity in the association of responses to cases, even during the subsequent export of data into statistical software.

In the middle section, you can select the columns to be imported as coded text or as variables.

If both “Code” and “Variable” are selected, MAXQDA will import the contents of this column as both as coded text and as a variable. This may be useful, for example, you do not wish to view the variable information of a document each time as a tooltip over a document name or in the Data Editor for document variables, but rather view, for example, how old a respondent is and whether he has children, directly in the text.

Please note: When the dialog box opens, MAXQDA will have marked all the columns in the Excel table which vary a lot as coded text, since these are most likely to be responses to open questions.

If neither “Code” nor “Variable” are selected, MAXQDA will ignore the column during the import process.

In the lower section, further options are available:

Code empty cells: When this option is selected, MAXQDA will import and code cells without content as empty paragraphs; these cells would otherwise not be coded.

You can also decide how MAXQDA should handle documents that were already included in the project before the import. MAXQDA considers that a document already exists in the project if the document name and document group are identical.

Import: When this option is selected, existing documents will be included in the import, and therefore may appear twice in the respective document group.

Ignore for import: Select this option if documents that already exist in the project should not be taken into account during the import.
Add text to existing documents: It is also possible to add text to existing documents. For example, data from different points in time in a longitudinal study can be added to the original document. Existing variable entries in existing documents will be updated. Empty variable values in the Excel table are ignored when importing.

Please note: For documents whose name appears repeatedly in a document group, the text will be added to the first document of the same name.

Selecting other settings for importing variables

If you choose to import variables, a second window will open after you click OK.

Source: By selecting this option, you can again decide which variables will be imported.

Target: If there is already a document variable with the same name in the project, MAXQDA assigns the variable to it automatically and no other choice is available. If there is no variable with the same name in the project, you can specify the type of variable. Options include: Boolean (true/false), date/time, decimal, integer, and text.

Preview data type: This column displays a preview of how an entry will appear in the appropriate column in the data editor.

A final report window confirms the import of documents from the table and lists how many texts, codes, and variables were imported, as well as how many documents may have been ignored during the import.

Imported texts in MAXQDA

After importing the table from the example into an empty MAXQDA project, it will appear as follows:
When importing, MAXQDA proceeds as follows:

- Document groups that do not yet exist will be created.
- The headings of the code columns will run from left to right and will be inserted from top to bottom in the code system as new code names, as long as they do not yet exist. All text segments from the code columns will be coded with the respective column headings. The complete heading of each column is recorded in the code memo.
- If a variable does not yet exist, it will be created. Each document will be assigned the variable value from the variable column.

In the section "Categorize Survey Data" you will find information on how to analyze the imported survey data in MAXQDA.

Survey Data from SurveyMonkey

Which import options does MAXQDA offer for SurveyMonkey data?

With MAXQDA you can import survey data directly from SurveyMonkey into an open MAXQDA project in order to analyze the data with all MAXQDA tools. The use of another software such as Excel for export and import is no longer required. While importing the data every case of the online survey becomes a MAXQDA document. You can code the answers of the open-ended questions automatically with the question text. Additionally, you can transform the standardized information into document variables.

**Please note:** In order to use this MAXQDA tool access to your own SurveyMonkey account is required. Not all SurveyMonkey plans allow access to the data by third-party applications like MAXQDA. Please check the website of SurveyMonkey, if your plan allows to export data (at present at least an EXTRA- or PREMIUM plan is necessary).

Starting the import process

To start the data import, proceed as described below:

- 1. Select **Documents > Import data from SurveyMonkey** in the main menu.
- 2. You will be redirected to the login page from SurveyMonkey in your Internet browser. Fill in your login data and click **Login**.
Please note: If it is the first time you connect with SurveyMonkey a window might appear asking for free access through your firewall. Please confirm that MAXQDA is allowed to contact the Internet. Otherwise the import is not possible.

Importing data

3. After a successful authorization of SurveyMonkey MAXQDA loads an overview of your surveys and displays the dialog below. In this window you can select the survey you want to import
4. Via the selection at the bottom you can choose whether you want to import every case or a random sample of the cases. After doing that click **Continue**.

5. A new dialog window appears. Here you can choose on the top which question shall be applied as document name. In order to guarantee a unified definition of the documents the case-ID is selected by default. In general it is advised to keep this selection.
In the center of the window you can choose the columns to import as coded text or as a variable. If you tick both marks MAXQDA imports the content of this column as both, a coded text and a variable. This can be useful if you want to read the information of the variable directly in the text (e.g. how old a person is or whether she has kids). By doing that you can avoid receiving this information only via the tooltip or the data editor of the document variables.

If you don’t place a tick mark on a column MAXQDA ignores this column for the import.

The selection at the bottom allows you to set the option **Code empty answers**. If you mark this option, MAXQDA imports and codes cells without content as empty paragraphs. Otherwise empty cells would not be coded.

After clicking **OK** the data will be imported:

- A new document group labelled with the name of the survey will be created.
- Every imported case in this document group will be imported into an own document.
- For each question that had been ticked in the column to import as a “code“ a new code will be created in the “Code System” window.
The imported documents contain answers to those questions that are selected automatically in the column “Code”. The answers are coded automatically with the particular question code. This gives you the opportunity to get an overview of every answer of a question just by using the Coding Query functions in MAXQDA.

![Data from SurveyMonkey after the MAXQDA import]

Information about the single question survey types

The question types from SurveyMonkey are imported into the MAXQDA project as described in the following table. You can determine whether an answer will be imported as an automatically coded answer to an open-ended question or/and as a document variable in the dialog that is shown before starting the import (see above).

<table>
<thead>
<tr>
<th>Question type</th>
<th>Standard import in MAXQDA</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiple Choice</td>
<td>1 variable</td>
</tr>
<tr>
<td></td>
<td>‘Other’ answer: automatically coded text</td>
</tr>
<tr>
<td>Dropdown</td>
<td>1 variable</td>
</tr>
<tr>
<td></td>
<td>‘Other’ answer: automatically coded text</td>
</tr>
<tr>
<td>Star Rating</td>
<td>1 variable</td>
</tr>
<tr>
<td>Matrix/ Rating Scale</td>
<td>1 variable per item</td>
</tr>
<tr>
<td>Net Promoter® Score</td>
<td>1 variable</td>
</tr>
<tr>
<td>Slider</td>
<td>1 variable</td>
</tr>
<tr>
<td>Single Textbox</td>
<td>Automatically coded text</td>
</tr>
<tr>
<td>Multiple Textboxes</td>
<td>Automatically coded text per textbox</td>
</tr>
<tr>
<td>Comment Box</td>
<td>Automatically coded text</td>
</tr>
</tbody>
</table>
Twitter Data

MAXQDA’s Twitter analysis features

MAXQDA allows you to import data directly from Twitter into an open project and to analyze it using MAXQDA’s usual functions as well as the specific analysis tool.

With a complex search, you can search for tweets on Twitter according to specific hashtags, usernames or terms, and then import them into a MAXQDA project. The function’s special feature is that it can code your Twitter data automatically with up to 100 author names and up to 100 hashtags during import (and, if necessary, later). This automatic preparation can save a lot of time, which you can then use for your actual analysis.

Researchers who analyze social media data can use MAXQDA to answer the following questions, among others:

- What did a user, user group or company post at a certain time? What were other users reaction to its content?
- Which are the most common words used in the tweets?
- How many followers do the people tweeting about particular topics have and what is the reach of individual tweets?
- On which weekdays and at what times were tweets on certain topics written?

Please note: To use this function, you need your own Twitter account.

Import Twitter data

To import twitter data, go to Import > Twitter Data.

The following dialog window will appear:

![Importing Twitter data dialog window](image)
In order for MAXQDA to import data directly from Twitter, you must first link your Twitter account to MAXQDA. To do so, click **Connect to Twitter** at the top of the dialog window:
Connect to Twitter

A new browser window will open where you can enter the login data of your Twitter account. Then, click Authorize App to allow MAXQDA to receive Twitter data from your account.

![Authorize MAXQDA to use your account?](image)

Authorize MAXQDA for Twitter

After registration, you can close the browser window and return to MAXQDA to start importing data.

**Please note:** MAXQDA uses the connection to Twitter only for importing tweets. When you close MAXQDA, the connection will be canceled, meaning you must reconnect to Twitter each time you restart MAXQDA.

**Searching for Twitter data**

The original dialog window that you opened in MAXQDA will remain open, indicating whose account is connected to MAXQDA. You can now check the box below the login button, which was previously greyed out. Only once you have agreed to the terms of using Twitter data neither for advertising purposes nor for personal identification can you start your search on Twitter. Once you agree to the terms, the search fields will become available.
The complex search follows the same principle as the advanced Twitter search. In the top fields, you can enter words or strings that must appear or not appear in the tweets. In the middle and lower sections, you can set define specific conditions for the search and the accounts to be searched:
From these accounts – searches for tweets from specific users. Multiple usernames can be entered, separated by commas.

To these Accounts – searches for tweets in which the entered username appears at the beginning of the tweet. Multiple usernames can be entered, separated by commas.

Mentioning these Accounts – searches for tweets in which the entered username appears somewhere in the tweet. Multiple usernames can be entered, separated by commas.

Further parameters can be set in the lower section:

Language: Limits the search to the selected language (the assignment of tweets to a language is done by Twitter itself and is not verified by MAXQDA). If you wish for tweets in all languages to be taken into account, allow the default parameter “Any language” to remain.

From/to: The default search period is set at seven days because this is the maximum period allowed by Twitter’s search function. You can reduce the search period, for example to one day, by adjusting the dates accordingly.

Include retweets: By default, this option is not selected. If you wish to include retweets in your analysis, simply place a checkmark in the appropriate checkbox at the bottom of the dialog window. (The inclusion and exclusion of retweets are managed by Twitter.)

Limit import to most recent tweets: If you wish to limit import to most recent tweets, this option allows you to set the specific size for import from 1 to 10,000 tweets. By default, 500 most recent tweets are imported.

Please note: All search criteria are linked with the search operator AND. This means that only tweets that meet all of the conditions entered will be retrieved.

After clicking the Run Search button, a preview window with the first 100 search results will appear. The number of tweets found is displayed on the lower left. When more than 100 search hits are found, the display is updated approximately every 10 seconds.
When you click **Import data**, MAXQDA will begin importing the tweets.

**Please note:** Imports are limited to 10,000 tweets.

Immediately after import, a dialog window will appear with the functions for **autocoding tweets**.

**Twitter data in MAXQDA**

During the import process MAXQDA creates a new document group in the Document System, in which a table document is generated for every 1,000 tweets.

To ensure transparency of the research process, the name of the document group contains the import date. A memo will also be created for the document group in which the search query is stored:
When you double-click on the document in the Document System, the Twitter data will be displayed in the Document Browser:

<table>
<thead>
<tr>
<th>Date/Time</th>
<th>Tweet</th>
<th>Hashtags</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>4/11/2018</td>
<td>In stead of protesting, do some fruitful work towards #balochistanfreedom movement.</td>
<td>balochistanfreedom</td>
<td>Reply</td>
</tr>
<tr>
<td>06:23:41</td>
<td>[MOJI] VIDEO: SATISFACTION, WANTS, DESIRES AND SIMPLICITY OF LIFE - <a href="https://t.co/19ndF9uOu6">https://t.co/19ndF9uOu6</a> #inspiration #yoga...</td>
<td>inspiration yoga</td>
<td>Tweet</td>
</tr>
<tr>
<td>4/11/2018</td>
<td>has difficulty finding satisfaction in life, but has a great ability to get along with almost anyone.</td>
<td>Libra</td>
<td>Tweet</td>
</tr>
<tr>
<td>06:05:05</td>
<td>[MOJI] VIDEO: SATISFACTION, WANTS, DESIRES AND SIMPLICITY OF LIFE - <a href="https://t.co/19ndF9uOu6">https://t.co/19ndF9uOu6</a> #inspiration #yoga...</td>
<td>Libra</td>
<td>Tweet</td>
</tr>
<tr>
<td>4/11/2018</td>
<td>has difficulty finding satisfaction in life, but has a great ability to get along with almost anyone.</td>
<td>Libra</td>
<td>Tweet</td>
</tr>
<tr>
<td>01:51:42</td>
<td>[MOJI] VIDEO: SATISFACTION, WANTS, DESIRES AND SIMPLICITY OF LIFE - <a href="https://t.co/19ndF9uOu6">https://t.co/19ndF9uOu6</a> #inspiration #yoga...</td>
<td>Libra</td>
<td>Tweet</td>
</tr>
</tbody>
</table>

Each imported Twitter document contains several columns, each named in the top line:

<table>
<thead>
<tr>
<th>Date/Time</th>
<th>The time when the tweet was sent</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tweet</td>
<td>Text of the tweets</td>
</tr>
</tbody>
</table>
Hashtags | All hashtags that occur in the tweet
--- | ---
Type | Marks whether a tweet is a retweet or a reply
Reply | Lists the Twitter name to which tweet was replied
Author und real name | Twitter name and real name of the author
Author location | Location entered by the Twitter user himself - not necessarily the location from which the tweet was sent (may be empty)
Author timezone | Time zone according to user (may be empty)
Author URL | Author’s website (may be empty)
Author description | Self-description of the author
Followers | Number of followers of the author (the higher the range of a tweet)
Follows | Number of people who follow the author
Tweets | Number of tweets
Profile verified by Twitter | Specifies whether the author's profile has been verified by Twitter
Profile created | Specifies how long the author has been registered on Twitter with their profile
Retweets | Number of times the tweet has been retweeted
Likes | Number of likes for the tweet
Language | Language in which the tweet was written (automatically recognized by Twitter)
Device | Device or software from which the tweet was sent
Tweet-Coordinates | Geoposition from which the tweet was sent (often empty)

**YouTube Data**

**What YouTube data analysis options does MAXQDA offer?**

YouTube videos are often commented on by viewers, and sometimes their comments sections even turn into forums for extensive debates, for instance in the case of videos on political topics. These comments can be very interesting to researchers working in diverse disciplines in the social sciences, as well as in market or opinion research.

MAXQDA allows you to import comments posted on a YouTube video into an open MAXQDA project and have them coded automatically. Additionally, you can import any transcripts or subtitles provided with the videos, which means you don’t have to transcribe them manually.
You can analyze the imported data using MAXQDA’s wide range of tools, including thematic coding, word frequency analysis, and visualization tools. These tools allow you to answer questions including, but not limited to, the following:

- What is the content of the comments posted on the selected videos?
- Which words are used most frequently in these comments?
- How have viewers rated the selected video?
- Which comments are replied to most frequently and which not at all?
- How do users communicate with each other?
- What is said in a video or in certain scenes?

Importing YouTube data

To import YouTube data into your MAXQDA project, first open the YouTube video in your browser (e.g. in Chrome, Firefox or Safari) and copy the complete link from the URL bar to the clipboard.

Go to **Import > YouTube Data** in MAXQDA.

You will then see the following dialog box. If you have saved a link for a YouTube video to the clipboard, MAXQDA automatically enters it in the first field and retrieves the corresponding video information. If you already have the dialog box open, you can paste a link from the clipboard into the field at any time and then click the button **Retrieve video information**.
In the upper area of the dialog box, MAXQDA will display how many comments and how many transcripts or subtitles assigned to the video are available to download.

**Please note:** YouTube does not allow you to download transcripts/subtitles for all videos, even if subtitles are displayed on the YouTube page of the video.

In the lower area of the dialog box, select whether you want to import the comments and transcript or just one of the two. The following options are available for importing comments:

**Import only top level comments** – If you choose this option, the replies to comments are ignored.

**Autocode comments** – If you select this option, each comment is automatically coded with a code. The code indicates how many replies were made to the comment. You should leave this option activated to give you easy access to the texts of comments later.
To import the transcripts, you can select or deselect all the available languages listed in the dialog box. The following options are also available:

**Include times in transcript** – If you select this option, the corresponding times in the video times are added at the beginning of each line of the transcript. This is useful if you don’t need to match the video to the transcript (in that case the times are displayed as MAXQDA timestamps at the beginning of each line).

**Link existing video file to transcript** – If you have downloaded the YouTube video, you can link it directly to the transcript. To do this, simply tick this option and select the video file by clicking on the three dots.

**Please note:** You can link video files to their transcript at any time later: MAXQDA saves the corresponding times during import and displays them later as timestamps.

**Imported comments in MAXQDA**

The following displays an example of the view in MAXQDA after you have imported YouTube comments:

![Imported YouTube comments in MAXQDA](image)

What happens when you import comments from YouTube?

- Comments are compiled in table documents, 1,000 comments at a time, in the "Document System". These table documents are labeled with a YouTube icon.
These table documents are stored in a document group whose name contains the video title and the import time. The corresponding document group memo contains more information about the video, such as the publication date and the number of likes.

A new code named "Autocode <Video Name and Import Time>" is added to the "Code System".

This code contains the subcode "Comment at top level with...", where as many subcodes are added to the code as there are different frequencies of replies to a comment. All comments are coded with the code according to their number of replies.

The second subcode is the code "Reply to comment". All replies are coded with this code.

To later display all the comments at the top level in the "Code System" to aid your analysis, you can do the following:

1. Activate all the documents containing the comments of one (or more) videos.
2. Activate the code "Comment at top level with..." including all subcodes.

The table document with the imported YouTube comments contains the following columns:

- **Nr.** – Consecutive numbering, where the answers to a comment are numbered starting at 1 for easy identification:
  - 0001 = oldest comment
  - 0001-01 = first reply to oldest comment
  - 0002 = second-oldest comment
  - 0002-35 = 35th reply to second-oldest comment
- **Comment** – The comment text
- **Author** – Name of the comment author
- **Author URL** – Link to the author’s profile
- **Top level** – Indicates whether the comment is a top level comment (i.e. not a reply). The cell will either contain the word "yes" or <empty>.
- **Replies** – Number of responses to a top-level comment. Always 0, if it is not a top-level comment, that is, a reply.
- **Likes** – Number of likes given to the comment
- **Published** – Date the comment was posted
- **Updated** – Date the comment was updated, if applicable

Please note: The YouTube comments import function is limited to the 10,000 most recent comments per video.
Imported YouTube transcripts

Here you can see a YouTube transcript once it has been imported into MAXQDA:

The transcript text is displayed in the “Document Browser”. In the example, a video file has been assigned to it such that timestamps can be seen in the column next to the paragraphs. Clicking on a timestamp plays the video at the corresponding position.

Subtitle Data (SRT)

Videos often come accompanied by text files that contain the spoken words of a video combined with the corresponding playback times such that the texts can be displayed as subtitles to the video. Very often the SRT format is used for these text files, which can be generated for YouTube videos, for example, using various software tools.

You can import these text files in SRT format into MAXQDA. Start the import as usual via Import > Texts, PDFs, Tables or right-click on a folder in the “Document System” and select Import Document(s). Then select an SRT file in the file dialog box.

MAXQDA imports the file and asks you for the corresponding video file.
The timestamps in the SRT file are converted into MAXQDA timestamps. Clicking on a timestamp plays the video file at the corresponding playback position.

If you have downloaded an SRT file assigned to a YouTube video, this file may have been created automatically. YouTube identifies places in these files that were not easily recognized by the automatic system in a light gray and gray font. This color coding is adopted by MAXQDA during the import. Please note that such automatically generated transcripts have no punctuation either, that is, without commas, full stops, or other punctuation.

**Web Pages**

With the MAXQDA Web Collector, you can save web pages, parts of web pages, or PDF files in your browser and then import them into MAXQDA in different formats as PDF, image, or text. Additionally, you can directly import web pages in HTML format as MAXQDA text documents.

**Saving web pages with the MAXQDA Web Collector**

The MAXQDA Web Collector is an extension for the Internet browser "Google Chrome". It allows you to save entire web pages and import the files as PDF, image, or text documents into MAXQDA. Among others, this tool is useful to compare websites from various organizations, or to collect content from web pages for analysis with MAXQDA.

**Installing the MAXQDA Web Collector**

In order to work with the MAXQDA Web Collector the installation of the Internet browser "Google Chrome" is required. As soon as "Chrome" is installed on your
computer you can start the installation of the "MAXQDA Web Collector":

1. Open "Google Chrome".
2. Search the Chrome Web Store for "MAXQDA" or use the following link: https://chrome.google.com/webstore/detail/web-collector-for-maxqda/jhnochbooihpgibgjcjlpiahaefohlakk
3. In order to add the extension to your browser click „+ Add“.

After a successful installation you can see a tiny MAXQDA icon top-right in your browser window (if not, please click on the “jigsaw” symbol and select the Web Collector to be displayed):

If you want to use the Web Collector just click on the MAXQDA icon:

The Web Collector offers four modes:

- Entire web page: the layout is preserved in the best possible way.
- Simplified web page: the web page will be reduced to key text and images as using a
read mode.
• Selections on web pages: only the selected part of the web page is collected.
• PDF documents: the whole PDF files is collected.

Collecting entire web pages

If your research is based on the analysis of every visible item of the web page it is recommended to safe the entire web page in order to import it to your MAXQDA project as true to the original as possible:

1. Open the web page you want to safe in Google Chrome.
2. When the web page is fully loaded open the Web Collector by clicking the tiny MAXQDA icon.
3. Make sure the tab “Web Page” is open.
4. If required, change the proposed document name. This name will later be inherited into the MAXQDA project.
5. If required, enter a text in the “Document Memo” box. This text will later be connected to the imported document as a document memo.
6. Click Collect.

The MAXQDA Web Collector saves the web page in the default download folder of your browser. The web page is saved in MWEB format that was specially developed for a further processing in MAXQDA.

Web pages that are saved this way can be imported into MAXQDA as a PDF or image document.

Collecting simplified web pages

In case your analysis focuses on the text of a web page you can safe it as “simplified” web page. The web page will be reduced to main text and images which can be compared to the read mode of your smartphone. This is particularly useful for big newspapers and magazines. In order to import a “simplified” web page proceed as described below:

1. Open the web page you want to safe in Google Chrome.
2. When the web page is fully loaded open the Web Collector by clicking the tiny MAXQDA icon.
3. Click on the “Simplified Web Page” tab. The web page will then be reduced to main parts.
4. If required, adjust further options such as font type, font size, and exclusion of images.
5. If required, change the proposed document name. This name will later be inherited
into the MAXQDA project.

6. If required, enter a text in the “Document Memo” box. This text will later be connected to the imported document as a document memo.

7. Click **Collect**.

The MAXQDA Web Collector saves the web page in the default download folder of your browser. The web page is saved in MWEB format that was specially developed for a further processing in MAXQDA.

**Please note:** Some web pages cannot be simplified for technical reasons. In this case, a message appears in the Web Collector window.

**Collecting parts of a web page**

In case you are only interested in a certain part of a web page you can download only the currently selection:

1. Highlight the segment you are interested in with your mouse.
2. Right-click the highlighted segment and choose **Collect Selection for MAXQDA**.

The MAXQDA Web Collector saves the selection in the default download folder of your browser. The selection is saved in MWEB format that was specially developed for a further processing in MAXQDA.

Segments that have been saved this way can be imported into MAXQDA as a text or PDF document.

**Collecting PDF documents**

To import PDF documents currently opened in Chrome follow these steps:

1. Open the Web Collector by clicking on the MAXQDA icon.
2. If required, change the proposed document name. This name will later be inherited into the MAXQDA project.
3. If required, enter a text in the “Document Memo” box. This text will later be connected to the imported document as a document memo.
4. Click **Collect**.

**Importing collected web pages into MAXQDA**

You can import a collected web page into your MAXQDA project by following these steps:
1. Open the MAXQDA project you want to import the saved web pages in.
2. Mark a document group in the "Document System" window by clicking on it in order to import the web page in a selected document group (if no document group is marked, MAXQDA will import the web pages into a new group)
3. Select **Import > Web Collector Data** in the main menu.

The following dialog window will appear:

![Import Web Collector data from the Import tab](image)

1. If you open the dialog for the first time MAXQDA selects the standard folder for downloads and displays it at the top of the box. Every collected web page located in this folder will be listed in the dialog. By clicking the three dots … you can choose any other folder to import collected web pages from the MAXQDA Web Collector.
2. Select every web page you want to import with the mouse. It will be highlighted green. By default, all listed web pages are selected).
Tip: Double click a row to open the downloaded file in the Internet browser. This allows you to check single web pages for their content.

3. Import options are provided at the bottom of the dialog:
   - you can select whether *web pages* should be imported as PDF or image documents
   - you can select whether *simplified web pages or selections* should be imported as PDF or text documents.
   - The option *Import new data only* can be used to import only data that does not yet exist in the open MAXQDA project. If checked, MAXQDA compares the collect date, the document name and the document type (text, PDF, image).

In order to start the import, click *Import selected files*. The time for import can vary depending on the scope and format of the selected document. A progress bar informs you about the import progress of each document.

In case you selected PDF or image format and you want to import big files, MAXQDA asks you whether you want to import them as externally saved files instead of saving them in the project (see *External Files* for more details).

Please note: The main layout will be adopted in the import process. Deviations from the web page’s original layout might occur especially as far as complex web pages are concerned.

Direct import of web pages in HTML format

1. You can also import an HTML file directly into MAXQDA. To do this, select *Import > Texts, PDFs, Tables* from the main menu. In the dialog box that appears, select the HTML file. Alternatively, you can drag and drop a HTML file into the "Document System" window with the mouse.
2. MAXQDA imports the file as a text document and includes images, if they were embedded in the HTML file.

Please note: If you use the direct import of web pages in HTML format they are imported as text documents (and not as web pages). The layout can change a lot during the import, which is why using the Web Collector for this task is clearly preferable. The direct HTML import is particularly suitable for simply structured and designed data.

Bibliographic Data (Endnote, Zotero etc.)
How Does MAXQDA Support Working with Bibliographical Data?

MAXQDA offers you the option to import bibliographic data from reference management programs such as Endnote, Mendeley, Citavi and Zotero in order to conduct literature reviews or to review the state of research in literature. Such programs are mainly used in the scientific field for literature work, which means that they primarily serve the administration of literature references and the creation of literature lists and support the creation of scientific texts. Similar to MAXQDA, the literature management programs work with projects, which are containers containing all collected bibliographic information. The units of the projects consist of literature references (author, title, etc.), for which digital versions of the full texts in PDF format are often stored as attachments.

MAXQDA is compatible with all literature management programs that are able to export their literature databases in RIS format, which is a standard format for bibliographic information. With the following programs it is possible to import the assigned full texts into MAXQDA in addition to the literature references:

- Endnote
- Mendeley
- Zotero
- Citavi

When imported into MAXQDA, each literature entry becomes its own text document. If full texts are imported, MAXQDA automatically connects the full text to the literature entry with an internal link. The individual information in the literature entries is automatically coded for later analysis so that, for example, all titles or abstracts can be compiled and searched. The attachments can be automatically coded during the import with the keywords assigned to them, and the notes for a literature entry can be saved as a document memo with the corresponding attachment.
Remarks on the RIS format

RIS is the short form for "Research Information System Format". RIS files are simple text files in which all exported literature entries are listed one after the other. RIS files contain so called " tags ", which consist of two letters and are followed by the corresponding information. Important tags include for example:

TY – Type of reference, always marks the beginning of a new entry
ID – Unique identification number for each entry
AU – Author
TI – Title
PY – Publication date
ER – Closes entry, always located at end of entry

A detailed description of all RIS format tags can be found on Wikipedia under http://en.wikipedia.org/wiki/RIS_(file_format). An example of RIS source data is listed below:
Exporting literature data from Citavi, Endnote, Mendeley or Zotero

Before importing literature data into MAXQDA, you must export the desired data from your literature management program in RIS format.

Export from Citavi

1. Select the literature entries you want to export.
2. Select **File > Export > Export...** from the main menu.
3. Choose **RIS** as the export filter. If this option is not displayed, click on **Add export filter**.
4. Click **Next**
5. Click **Search...**, enter a name and select a directory
6. Click **Next** and again click **Next**

Export from Endnote
1. Select the literature entries you want to export.
2. Select **File > Export...** from the main menu.
3. Enter a file name and select a directory.
4. Set the file type to “Text Only” and the output style to “RefMan (RIS) Export” as shown in the following picture. If this output style is not available, open the selection list and select "Select Another Style..." at the top, where you can search for the output style.
5. Click **Save**

**Export from Mendeley**

1. Select the literature entries you want to export.
2. Select **File > Export...** from the main menu.
3. Enter a file name and select a directory.
4. Set the file type to “RIS - Research Information Systems (*.ris)“.
5. Click **Save**

**Export from Zotero**
1. Right-click on a collection and choose **Export Collection...** Alternatively, choose **File > Export Library...** from the main menu to export the entire library.

2. In the appearing dialog select "RIS" as the format.

3. If you want to export the notes and the associated files (especially the full texts), make sure to check the corresponding boxes for **Export Notes** and **Export Files**.

4. After clicking **OK**, assign a file name and select a directory.

5. Click **Save**

**Starting the Import in MAXQDA**

After you have exported the desired data, select **Import > Reference Manager Data > Import from Citavi/Endnote/Mendeley/Zotero** in MAXQDA. The following dialog appears:
Click **Select File...** to select the exported file in RIS format. This file has either the extension RIS (Citavi/Mendeley/Zotero) or TXT (Endnote).

MAXQDA analyzes the file and shows you various options for importing it. First you can choose if you want to import the references as well as the attachments (full texts) or only one of them.

**Tip:** MAXQDA checks by author, year, title and publication type which bibliographical references and which attachments already exist in the project file and indicates in brackets how much new data is added by the import. MAXQDA only imports new entries so that no duplicates are created.

For the import of attachments the following options are available:

**Only PDF files** - Select this option to ignore all other file formats such as Word documents when importing appendices.

**Autocode keywords** - By setting this option, a small area with all keywords contained in the literature reference is coded at the beginning of each attachment. This makes it easy to select full texts based on the keywords assigned to them. Please note that the keywords contained in a literature reference do not necessarily have to match the keywords actually assigned in the text by the authors.
Add notes as document memos - If this option is enabled, all notes for a literature reference are added as document memos in the "Document System". The tag N1 of the RIS format is evaluated for the notes.

Store attachments in folder for external files - If this option is disabled, all PDF and image files will be copied to the MAXQDA project file. This is usually recommended if there are only a few or small attachments. If this option is enabled, PDF and image files will be saved in the External Files folder, so the project file itself will remain very small. Here you can find more information about externally stored files.

If you want to import attachments from Endnote, you have to click on Select file... at the bottom of the dialog to tell MAXQDA where the Endnote library from which you exported the data is located in your file system. This is necessary for MAXQDA to know where the attachments are located. The Endnote library has the file extension ENL.

By clicking OK the import process is started.

Import bibliographic data from other programs

If you neither use Citavi, Endnote, Mendeley nor Zotero, you can still import a RIS file with bibliographic information. Export all desired references from your program in RIS format.

Tip: You can also export search results in RIS format from an online journal or catalogue, for example to analyse how the thematic focus of a journal’s titles has changed over the years.

Switch to the tab Import in MAXQDA and select the entry Reference Manager Data > Import Bibliographic Data from RIS File. A short explanation window will appear and then a selection dialog which lists only files with the endings RIS or TXT. Select the exported file and confirm your selection with OK.

Please note: When using this import option, no attachments (full texts) are imported.

What happens during the import?

- A document group "REFERENCES" is created in the "Document System".
- All literature entries are added to the newly created document group as individual text documents. The entries are sorted alphabetically and marked with their own symbols.
- The document name consists of the surnames and first names of the authors as well
as the year. In the case of two authors these are linked with "&", in the case of three or more authors only the first author is mentioned and "et al." is added.

- In the "Code System" a code "REFERENCES" with the two subcodes "RIS" and "KEYWORDS" is generated. The code "RIS" contains all RIS tags used in the import file as subcodes, e.g. "Type of reference" or "Abstract". The code "KEYWORDS" contains all keywords assigned in the literature references as subcodes.

- When importing, all references are automatically coded by coding each text section with the corresponding RIS code.

- Each keyword in the literature reference is coded with the corresponding keyword in the code system.

- DOI links are inserted into the text as hyperlinks, so that you can access the online version of a publication directly if required.

If attachments are imported, the following will also happen:

- A document group "REFERENCES > ATTACHMENTS" is created in the "Document System".

- All attachments are imported into this document group as separate documents.

- The documents retain their file names and are sorted in alphabetical ascending order of their references. The sorting of the document names is therefore not necessarily alphabetical and the same document names may occur several times, e.g. if there are several documents with "Table of Contents".

And if references and attachments are imported:

- Internal links are additionally created, which link the literature reference with the corresponding attachments, so that you can jump back and forth between literature reference and full text with a single click. In the literature reference, the internal link can be found in the "Link to PDF (L1)" section (the name comes from the RIS format and also applies if it is a file format other than PDF). In the attachment, the internal link is placed at the beginning of the document.

**Adopting selected information as variables**

The following variables are automatically assigned to each newly created document when importing literature data, including attachments if imported.

- **RIS_Type (Type of reference)** – Text variable
- **RIS_Author (First author)** – Text variable
- **RIS_Title (Title)** – Text variable
- **RIS_Reference-ID (Identification number of the entry in the literature database, is only exported by a few programs, e.g. Endnote)** – Integer
- **RIS_Year (Year of publication)** – Integer
The variables are created as system variables and cannot be changed by the user.

Analyzing literature data in MAXQDA

After the import and the automatic pre-coding, the bibliographic data and the corresponding full texts are available in MAXQDA like normal documents. This means that they can be searched, coded, linked and assigned memos and are available for further analysis. Of course, the Visual Tools and all other functions such as the graphics and statistics functions can also be used. By importing the variable values, for example, only documents of a certain type can be selected for analyses, such as journal articles or anthology articles, or only publications from a certain year.

Some initial ideas for the analysis:

- Right-click on a keyword in the code system and select the function **Activate Documents Containing this Code**. MAXQDA will then activate all literature entries and attachments to which this keyword has been assigned.
- Double click on “RIS > Abstract” to open all abstracts in the "Coded segments" overview. Start the **Smart Coding Tool** by clicking on the symbol bearing the same name in the toolbar to encode and systematize the abstracts.
- Activate the document group "REFERENCES" and activate the code "RIS > Title" to list all titles in the "Retrieved Segments" window. Click on the **Word Cloud** icon to start an analysis of the (most common) words in the title.

If you want to learn more about how to conduct literature reviews with MAXQDA, check out our PDF guide:

**Literature Review Guide**
Exporting bibliographic data in RIS format

Bibliographic data from a MAXQDA project can be exported in RIS format for import into a reference management program, for example. The export function can be found in the Reports tab. Click on the Export icon and select the Bibliographic Data as RIS File entry from the menu.

After you have specified a saving directory, all documents of the project that contain literature references (indicated with a book symbol) are exported to a RIS file with UTF-8 encoding.

Structured Documents (Preprocessor)

What are structured texts?

Often you may wish to import documents that are structured and pre-coded. Examples for this kind of document include:

- **Forms**: Here you would like to code each section with its respective heading for the field in the form.
- **Questionnaires filled in by the respondents in a structured text file**: Here you may wish to code the answers with their respective questions or instructions.
- **Asynchronous online discussions**: that you have retrieved with online tools and already tagged.

The problem is similar in each case: before the actual analysis has begun certain text sections have already been allotted to specific form fields or similar. And you would like to save yourself the effort of manually coding each. To solve this problem, MAXQDA has the preprocessor that allows you to split a text file into several text documents during its import and to code labeled text areas with one or more codes.

Import structured data with the preprocessor

The preprocessor lets you enter a large number of documents into a single file and have them separated out into different documents when imported into MAXQDA. The syntax rules are as follows:

```
#TEXT textname this is the content of the 1st text...
#TEXT textname this is the content of the 2nd text...
#TEXT textname...
```
Every document must start with the “#TEXT” and “TEXT” must be written in capital letters.

The name that you want to give to the document should come immediately after the “#TEXT” without a space in between. If you do not enter a name, MAXQDA will automatically assign one when the document is imported. The first imported document will be called “Document nn,” and the following documents will be named in sequential order in the “Document System.” This automatic numbering is useful when, for example, you enter the answers to open questions in a partly standardized survey. The answers must then simply be entered in the order of the standardized data in the SPSS file. It is not necessary to enter a name for each text. Both texts will have the same name.

Document names are handled by MAXQDA as follows. You can enter any kind of string (up to 63 characters) as a document name – spaces are also allowed. If you enter a document name with more than 63 characters, MAXQDA will truncate it automatically. Once the document has been imported into MAXQDA, you can change the name to include up to 64 characters.

Example

In the example project, various interviewees were asked about their level of satisfaction with various aspects of their life. Their answers were transcribed and imported as Word documents.

The resulting Word file appears as follows:

```
#TEXT 4(26,f,0k,sin)
I've gained too much weight over the last several years and I don't seem to be doing anything to get rid of it. I have high cholesterol levels, but I don't attempt to change my eating habits. I'd like to jolt myself into becoming more physically active, so I can lose the weight and feel more energetic. I keep saying I'm going to do something about it, soon.

#TEXT 3(34,f,2k,mar)
Overall I am pretty happy with my mental, social and physical health. I would like to improve my dedication to working out. I am the type of person who will work out 5 times a week for a month straight and then is slowly turns into less days a week until it is none. I get distracted by school work, my job or just being tired.
```

After each #TEXT entry is the name being given to the document. For the purposes of this project, it made sense to assign a number for each of the interviewees in addition to some basic information about that person, including age, gender, number of kids, and marriage status.
The Word file was then saved with the name “HealthSatisfaction” in RTF or DOC/X format. It could then be imported by going to the **Import** tab and selecting **Structured Text**.

**Tip:** MAXQDA automatically creates a new document group in the „Document System“ during import and inserts all texts into this document group.

All texts will appear in the „Document System“ after being successfully imported. The documents are named as previously specified followed by #TEXT as an identifying agent. In the above example, the document name consists only of a text number and the personal data indicated in parentheses.

![Documents after being imported with the Preprocessor](image)

### Pre-coding text segments during import

The document is then imported, separating out each individual document and assigning the given name for each in the „Document System“ from the original RTF document.

In this way, it is possible to very quickly import and separate out many different documents formerly contained in a single file. The Preprocessor is able to do significantly more than this simple action, however. In many cases, you will already be able to code aspects of the document, and the Preprocessor can do that automatically during the import. To do so, you simply need to use additional syntax words.

For each section of the document that is to be coded, you simply need to type “#CODE” before and “#ENDCODE” after. In the case of a standardized survey or questionnaire, you could, for example, code each answer with the question number that it connects to. The answer to the first question, then, could be coded with the code “Question1“ as is shown below.
Important: It is important to remember that "CODE" is written in capital letters.

To avoid typos when entering "CODEquestion1," it is possible to simply use a place holder, such as “§1” for the first question, “§2” for the second, etc. You can then later do an automatic search and replace, finding all instances of “§” and automatically replacing it with "CODEquestion." This can save you a lot of time in addition to helping you avoid typos.

It is also possible to define and code with a subcode in a document prepared for the Preprocessor. To do so, use the following syntax:

#CODE Codename\Subcodename

You are giving the complete information about the subcode, including its name and the code it is a subcode of. The code and subcode are separated by a “” symbol, but no spaces. As with any codes used in a document imported with the Preprocessor, MAXQDA will first check whether the code already exists, and if it does not, it will be created.

Important: As soon as “#CODE” appears in the text, the new code will be used, automatically ending the coded segment of the previous code.

Text excerpts, as well as full paragraphs, can be pre-coded with the help of the preprocessor during import, as shown by the following example:

#TEXTTextname
Here is a text. Encoding begins here with #CODECode 1\Subcode#. In the next sentence it ends with #ENDCODE# in the middle
#CODECode 2
Here is another text. The encoding ends here #ENDCODE# in the middle of the text....
For a preliminary encoding of keywords from various text excerpts, the following rules apply:

- When the keywords #CODE or #ENDCODE appear alone in a row, it is not necessary to insert # at the end. If these keywords appear within a text, or at the end of a line of text, they must be enclosed with #.
- It is not possible to “layer” encodings. When a new #CODE# command comes before an #ENDCODE# command, the previous code is automatically closed.

**Tip:** To assign several codes to a text part you can combine the codes with two “&&” characters, e.g. #CODEFirst code && Second code && Third code

**Mark participants of a focus group**

If you use the tag #SPEAKER inside a text section, MAXQDA will import the text as a focus group transcript and will code the text after the tag with a speaker code. The tag #ENDSPEAKER closes the speaker coding. The tag may be inserted within a sentence, but then a # has to be added after the name of the speaker.

```plaintext
#TEXTFocus group 1

#SPEAKERModerator
A warmly welcome to our session …
#ENDSPEAKER

#SPEAKERParticipant 1
#CODETheme 1
I have the following opinion
#ENDCODE
#ENDSPEAKER
```

This function is very interesting for exporting data that have been collected online with the tool [http://www.kernwert.com](http://www.kernwert.com).